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END USER LICENCE
This Licence (and the terms and conditions contained within it) is a legal agreement between you (the End User) and Global Graphics Software
Limited, a company incorporated in England with Company No 2049413 with registered office at Barrington Hall, Barrington, Cambridge CB2
5RG or in the United States with Global Graphics Software Inc, a company incorporated in Massachusetts, with a principal address at 95
Sawyer Road, Three University Park, Waltham, MA 02453 (both defined for the purpose of this Licence as Global Graphics). This Licence sets
out the terms upon which Global Graphics and its licensors licences to the End User the Software. The End User must only install and use the
Software in accordance with the terms of this Licence and the End User’s particular attention is drawn to the terms of the licence (Clause 2) (and
the restrictions and prohibitions contained within that Clause), the limited warranty (Clause 3) and the limitation of liability (Clause 4).
By installing, loading, copying, storing or otherwise using the Software, the End User agrees to be bound by the terms of this Licence. If the End
User does not wish to be bound by the terms of this Licence, the End User should not install, load, copy, store or otherwise use the Software, and
return the Software or the Documentation for a refund of the Total Charges.

1

INTERPRETATION
1.1

The expressions set out below shall have the meanings in this Licence ascribed to below:
Charges mean the fee payable by each End User as identified in the Purchase Order and Total Charges means the total fees payable
by all End User’s;
End Users means the individual or company licensed to use the Software under or in respect of this Licence as set out in the
Purchase Order;
Intellectual Property means copyright, domain names, design rights, database rights, semi-conductor topographical rights, patents,
trade marks (registered or unregistered), service marks, registered designs or any applications thereof, and all other intellectual or
industrial property rights of a similar nature and Intellectual Property Rights means rights in such intellectual property;
Purchase Order means the written or electronic order for the Software submitted by the End User;
Software means the registered version of the JAWS PDF Creator, together with any changes, modifications, adaptations or
alterations thereto together with any subsequent versions, releases and corrections and any accompanying documentation.

2

LICENCE
2.1
2.2

In consideration of the payment by the End User of the Total Charges, Global Graphics grants to the End User, a non exclusive, non
transferable right to install and use the Software on the terms of this Licence
The End User’s rights and obligations in respect to the use of the Software is as follows:
The End User may:

2.3

install and use the number of copies set out in the Purchase Order, provided always that only one copy of the Software on a single
computer subject to both the following conditions being satisfied
(a) End User interaction is required to operate the Software;
(b) there is a one-to-one (1:1) relationship between the End User and the Software.
For the avoidance of doubt the End User is responsible for the installation of the Software and installation must be performed in
accordance with the terms of the documentation accompanying the Software.

2.4

make one copy of the Software for archival purposes, provided the archive copy is not installed or used on any computer;

2.5

use the Software on a network, provided that the End User has a licensed copy of the Software for each computer that can access the
Software over the network. For the avoidance of doubt the End User must not exceed the total numbers of licensed copies set out in
the Purchase Order;

2.6

install an additional copy of the Software on a home or portable computer, provided that the End User is the primary user of the
computer on which the Software was first installed. However, the Software on the secondary computer may not be used by another
person at the same time the Software on the primary computer is being used;

2.7

install additional copies of the Software on the same computer, where the computer is capable of running more than one operating
system (a “multi-boot” system) provided that only one copy of the Software is available for use at any one time;
The End User shall not (and shall procure that any third party shall not):

2.8

copy or make derivative works from the Software, except as set out above. Any copies that you are permitted to make pursuant to
this Licence must contain the same copyright and other proprietary notices that appear on or in the Software;

2.9

sublicense, assign, rent, lease, lend, export or re-export or otherwise market or distribute the Software, or any portion thereof

2.10 Modify, change, alter, adapt, translate, reverse engineer, decompile, disassemble or otherwise attempt to discover the source code of
the Software, or create derivative works from the Software, except that in the European Community, you may reverse engineer only
for interoperability purposes and then only if all conditions of Article 6 of Council Directive 91/250/EEC are met.

3

WARRANTY
3.1

Global Graphics warrants to the End User that the Software will perform substantially in accordance with the documentation
supplied with the Software for the ninety (90) day period following receipt by the End User of the Software. To make a warranty
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claim, the End User must return the Software to the location where obtained it together with a copy of proof of purchase within
such ninety (90) day period.
3.2

If the Software does not perform substantially in accordance with the documentation supplied with the Software, the entire and
exclusive liability and remedy shall be limited to either, at Global Graphics option.
3.2.1 the replacement of the Software; or
3.2.2 the refund of the Total Charges

3.3

4

The warranty set out in this Clause 3.1, and the entire and exclusive liability and remedy set out in Clause 3.2 states the sole and
exclusive obligation of Global Graphics to the End User and sets out the entire remedies which Global Graphics and/or its licensors
have to the End User for breach of this warranty.

LIMITATION OF LIABILITY
4.1

Neither party excludes or limits liability to the other party for death or personal injury caused by negligence or for fraud or
fraudulent misrepresentation nor where liability cannot be excluded or limited as a matter of law (e.g. breach of any obligations
implied by Section 12 of the Sale of Goods Act 1979 (as amended) or Section 2 of the Supply of Goods and Services Act 1982).

4.2

Subject to the provision of Clause 3.1 and 4.1, all representations, warranties, conditions whether implied by statute or otherwise
are excluded from this Licence. In the case of representations, warranties, conditions implied by statute these are excluded to the
fullest extent permitted by law. [In particular, Global Graphics and its licensors are not aware of the purposes for which the End
User is to use the Software make no warranties, express or implied, as to the Software’s fitness for any particular purpose.]

4.3

The End Users attention is also drawn to the following and subject always to the provisions of Clauses 3.1 and 4.1, Global Graphics
and its licensors:
4.3.1 do not and cannot warrant that the Software is free from minor errors not materially affecting the performance or
functionality of the Software;
4.3.2 do not and cannot warrant that the Software is and will be free from viruses (including, but not limited to, hidden routines,
worms, logic or time bombs, disabling or disruptive codes or routines, expiration dates and software switches). However,
whilst Global Graphics has used reasonable endeavours and taken all reasonable steps to check the same, the End User is
solely responsible for performing virus and other checks on the Software.
4.3.3 are not and shall not be liable for any failure or malfunction resulting wholly or to any material extent from the negligence,
operator error, any other misuse or abuse of the Software;
4.3.4 are not and shall not be liable for any failure to comply with the terms of this Licence including but not limited to, the
decompilation, transfer, disassembly, reverse engineering, modification, alteration or adaptation of the Software or its merger
with any other program or any maintenance repair adjustment alteration or enhancement of the Software by any person other
than Global Graphics;
4.3.5 are not and shall not be liable for any failure by the End User to implement recommendations advised by Global Graphics in
respect of, or solutions for faults in, the Software.

4.4
4.5

Subject always to the provisions of Clause 4.1, the aggregate liability of Global Graphics under this Licence (without prejudice to
any non-financial remedies), in contract, tort, misrepresentation or otherwise shall be limited to the Total Charges.
For the avoidance of doubt, the Supplier shall not have any liability to the Customer for any:
4.5.1 loss of profit, loss of use, loss of savings, goodwill or business interruption; or,
4.5.2 indirect, economic, consequential, special or financial loss or damage; or
4.5.3 loss of data.

5
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iv

INTELLECTUAL PROPERTY, OWNERSHIP AND RISK
5.1

The Software is and remains the property of Global Graphics and/or its licensors and is protected by amongst other things by
copyright law. All right, title to, ownership of and all Intellectual Property Rights and all other proprietary rights in the Software
belong to and shall belong to, vest in and shall remain vested in Global Graphics (and its licensors as the case may be).

5.2

In addition, and for the avoidance of doubt, the End User shall have no right to use Global Graphics or its licensor’s trademarks
with its promotion or publication of the Software, without Global Graphics written approval.

5.3

The End User shall not remove any product identification, copyright notices, trade marks or other legends set forth on the Software
and shall reproduce all such notices on any copies.

5.4

Risk in the Software passes to the End User on delivery.

CONFIDENTIALITY
6.1

The Software is owned by Global Graphics and its licensor(s) and is protected by copyright law, trade secret law, and as otherwise
set forth in this Licence.

6.2

The End User agrees not to disclose or make available the Software, or any portion or copy thereof, or the results of any benchmark
tests using the Software, to any third party without Global Graphics prior written consent.
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TERMINATION
7.1

Global Graphics may terminate this Licence immediately as notice if you fail to comply with any of the terms and conditions of this
Agreement. Upon termination, the End User shall cease using the Software and shall remove the Software from any personal
computer or server and destroy all copies of the Software. Termination of this Agreement shall be without prejudice to the other
rights and remedies of the either party.

7.2

The provisions of Clauses 4,5 and 6 shall survive the termination of this Agreement as shall any provisions which are expressed, or
by implication are intended, to survive termination of this Agreement.

GENERAL
8.1

This Licence shall be governed in all respects by English Law and subject to the non-exclusive jurisdiction of the English Courts.

8.2

This Licence is personal to the Global Graphics and the End User. Neither party shall assign, novate, sub-contract or otherwise
dispose of all or any part thereof without the previous consent in writing of the other party.

8.3

No variation of this Licence shall be binding upon the parties unless the same shall be in writing duly signed by a director on its
behalf and such variation shall be peculiar to the circumstances mentioned by such writing and shall not be regarded as a general
variation. The failure of either party to insist upon strict performance of any provision of this Licence, or the failure of either party
to exercise any right or remedy to which it is entitled hereunder, shall not constitute a waiver thereof and shall not cause a
diminution of the obligations established by this Licence.

8.4

Except as otherwise expressly provided no Licence communication from one party to the other shall have any validity under this
Licence unless made in writing by or on behalf of either party. Any notice or other communication whatsoever which is required or
authorised by this Licence to give or make to the other, shall be served by e-mail, facsimile or post in a prepaid first class letter,
addressed to Global Graphics at the registered office set out in the pre amble to this Licence. If any notice or other communication
is sent by e-mail, the sender shall confirm the communication by way of a letter sent by first class post. Any letters sent by first class
post which is not returned as being undelivered that notice or communication shall be deemed for the purposes of this Licence to
have been given or made on the second day after posting. Any notice served by facsimile or telex shall be considered to have been
delivered when actually received by the recipient.

8.5

This Licence together with the Schedule to it, represents the entire agreement between the parties and supersedes all prior
agreements, arrangements and understanding between the parties to that subject matter.

8.6

Pursuant to section 1(2) of the Contracts (Rights of Third Parties) Act 1999, the parties intend that no term of this Licence may be
enforced by a person who is not a party to this Licence but this does not affect any right or remedy of a third party which exists or
is available apart from under that act.

8.7

If any provision of this Agreement is held invalid, illegal or unenforceable for any reason by any court of competent jurisdiction,
such provision shall be severed and the remainder of the provisions hereof shall continue in full force and effect as if this Licence had
been executed with the invalid, illegal or unenforceable provision eliminated.

U.S. GOVERNMENT SUPPLY
9.1

This Software is a commercial computer software program developed at private expense and is subject to the following Restricted
Rights Legend: “Use, duplication, or disclosure by the United States Government is subject to restrictions as set forth in (i) FAR
52.227-14 Alt III, (ii) FAR 52.227-19; as applicable. Use by agencies of the Department of Defence (DOD) is subject to Global
Graphics customary commercial license as contained in the accompanying license agreement, in accordance with DFAR 227.7202-1
(a). For purposes of the FAR, the Software shall be deemed ‘unpublished’ and licensed with disclosure prohibitions, rights reserved
under the copyright laws of the United States.

10 CONTACT INFORMATION
10.1 Help and assistance together with detail of support and maintenance are available on the website details of which are set out in the
documentation accompanying the Software. The End User should wherever possible seek help and assistance from and contact
Global Graphics via the website, however any written communications should be sent to the registered office, details of which are
set out in the pre amble to this Licence. If sending mail, or leaving bug reports on the web server, please remember to include at least
your email address so that we can reply to you.

Europe:

Web:

Global Graphics Software Limited
Barrington Hall
Barrington
Cambridge, CB2 5RG
UK

www.jawspdf.com
E-mail:
sales@jawspdf.com

telephone +44 1223 873 800
fax +44 1223 873 873
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Jaws PDF Creator

1 INTRODUCTION
Jaws PDF Creator converts PostScript language files into PDF (Portable Document Format) files. These files can subsequently be used with Adobe® Acrobat®
products, or any other third-party PDF tools. The PDF files produced by PDF
Creator are fully compliant with the PDF 1.3 specifications published by Adobe.
PDF Creator has two modes of operation:
•

The application is embedded into the printing system of your computer’s
Operating System so that it appears as a PostScript compatible printer to
applications running on that computer. You can produce a PDF file from
any document by printing the document to the Jaws PDF Creator printer in
the same way that you would produce hard-copy by printing to a real
printer.

•

Also included is a program called Jaws ToPDF which takes an existing
PostScript language file – either a legacy file or a file produced on another
computer – and converts it to PDF. This program provides a small user
interface which lets you treat PDF Creator as a stand-alone application,
similar to Adobe Acrobat Distiller®.

Jaws PDF Creator 2.1: issue date January 2002

1

Jaws PDF Creator

•

When creating PDF files, the printing system produces an intermediate
PostScript language form of your document, which PDF Creator immediately converts to PDF and writes to disk.

Jaws PDF Creator works with PostScript printer drivers from Microsoft, Apple
and Adobe, although, on a Windows system, Microsoft drivers are generally to be
preferred (for reasons discussed in more detail later).
Because PDF Creator is integrated into the printing system, it has no user interface
of its own. However, it does have a Control Panel which allows you to configure
various parameters affecting the final PDF output.

1.1 About this manual
This manual is intended as a guide to the installation and use of PDF Creator.
•

Section 2 describes how to install, upgrade and uninstall PDF Creator.

•

Section 3 covers basic use of both the Jaws PDF Creator printer and the
Jaws ToPDF front-end.

•

Section 4 describes the Jaws ToPDF application in more detail.

•

Section 5 provides a comprehensive reference for the PDF Creator Control
Panel. This is where most of the configuration is done.

•

Section 6 describes how to use and configure the Jaws PDF Creator macro
for Microsoft Word on Windows.

•

Section 7 is the troubleshooting guide.

•

Section 8 is where you will find all the support information you may
require, such as how to register your copy and download new versions.

•

Section 9 is the location of all the required contact information.

•

Section A contains technical and more advanced information about PDF
Creator as well as a map of all the installed files.

Throughout this manual, references to Acrobat Reader™ should be understood to
apply equally to Acrobat®.
This manual describes Jaws PDF Creator operation on both the Microsoft Windows and the Apple Macintosh platforms. Differences in operation, or features
are indicated by using different headings or separate paragraphs.
2
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1.2 System Requirements
The system requirements are:
•

Windows 95, 98, ME, 2000, XP or NT4 for Intel.

•

MacOS 8.5 or later.

•

At least 10 MBytes of free disk space.

•

Memory requirement is heavily dependent on the nature of the job being
converted into a PDF file.
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2 INSTALLING AND UNINSTALLING PDF CREATOR
If you are using Niknak (v1.1) on your system, it is recommended that you uninstall it before installing Jaws PDF Creator. If you are using an earlier version of
5D PDF Creator on your system, there is no need to uninstall before installing the
current version.

2.1 Installation – Microsoft Windows
Jaws PDF Creator is supplied on CD-ROM with its own installer. If you have
Autorun enabled, the installer starts automatically when you insert the CD-ROM
into the drive. Otherwise use one of the following three options:
1. Select Settings > Control Panel from the Start menu. In the Control Panel
window select Add/Remove Programs, and click the Install... button on the
dialog box which appears.
Enter D:\setup.exe followed by clicking the Finish button.
2. Select Run... from the start menu and then enter D:\setup.exe. If your CDROM is assigned to a different drive letter, enter a different file name
accordingly; then click OK.
3. Using Explorer, open the root folder for your CD-ROM drive and doubleclick the program setup.exe.
At this point the Jaws PDF Creator InstallShield Wizard will appear
prompting for a password. To complete the installation follow the instructions displayed on the screen.
If you do not have a password for the installer contact:
www.jawspdf.com.

2.2 Installation – MacOS
To install PDF Creator on MacOS:
1. Temporarily disable any virus detection software or non-essential extensions
or Control Panels.
2. Double-click the installer application that appears on your desktop when
you insert the CD-ROM into the drive.
3. Follow the on-screen instructions to install Jaws PDF Creator.

4
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2.3 Serial number
If you have a serial number for your version of Jaws PDF Creator you can use it at
installation time. This will immediately give you a licensed and fully featured version of the application.
If however you wish to evaluate the product, you can install it without a serial
number.
Windows: Enter the word EVALUATION in place of the serial number.
MacOS: Click the Evaluation button.
This will provide you with a working copy of the application. In this case, all
PDFs generated by the application will contain a watermark on every page.

2.4 Upgrade from evaluation to a fully working version
When you have evaluated Jaws PDF Creator you may wish to upgrade to a fully
working version.
Windows: Go to the Settings tab of the Configure Jaws PDF Creator
Control Panel and click the About Jaws PDF Creator button.
MacOS: Open the Jaws ToPDF application then select About Jaws PDF
Creator from the Apple menu.
The About dialog will appear. If you do not have a valid serial number select the
link to the Jaws web site (www.jawspdf.com) and go to the Buy page and follow
the instructions.
When you have your serial number you can upgrade your version of Jaws PDF
Creator.
Windows: Click the Enter Serial Number option in the About Jaws PDF
Creator dialog.
MacOS: Open the Jaws ToPDF application then select Enter Serial Number
from the Apple menu.
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The following dialog will appear:

Enter your name, company and serial number and select OK.
The user name must consist of at least two characters. The company name is
optional.
Your version of PDF Creator will become licensed and fully functional.
If required, you can amend an existing serial number or even remove it and revert
to an evaluation copy (possibly required if you want to check out the facilities of a
new version).
Note: Under Windows 2000 a user may not be able to upgrade to a fully operational version of Jaws PDF Creator. This is because the information regarding
serial numbers is stored in a part of the system registry, which is normally only
accessible to those users with Administrative privileges.

2.5 Uninstall PDF Creator from Windows
To remove Jaws PDF Creator from a Windows computer:
1. Select Settings > Control Panel from the Start menu.
2. In the Control Panel click Add/Remove programs and select Jaws PDF
Creator in the list.
3. Click the Add/Remove button to remove the program.
A confirmation prompt is displayed.

6
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In some circumstances the uninstaller is unable to remove the PDF Creator printer
from the Windows printing system. If this happens a message is displayed asking
you to wait a few minutes and re-attempt the uninstall. If the second attempt also
fails, you should reboot your computer and uninstall again.

2.6 Uninstall PDF Creator from MacOS
To remove PDF Creator from a MacOS computer:
1. Double-click the install application followed by clicking Continue in the
splash screen.
2. In the End User Licence Agreement dialog click Accept to display the
installer’s main window.
3. Select Uninstall from the menu at the top left of the window and click the
Uninstall button.
4. Once the removal has completed, drag the PDF Creator Desktop Printer
icon to the Trash.
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3 GETTING STARTED WITH PDF CREATOR
This section describes the main features of PDF Creator and how to use them.

3.1 Create a PDF file from an application
To create a PDF file directly from an application, print the document in the
normal way being sure to select Jaws PDF Creator as the printer.
Windows: When the OK button is clicked in the Print dialog a Create PDF
dialog appears allowing you to choose the location and name of the PDF
file. Clicking Save completes the process.
Do not select the Print to File option. PDF Creator always prints to a PDF
file. If you select this option you will create a PostScript file instead.
MacOS: When the Print button is clicked in the Print dialog a Save dialog
appears allowing you to choose the location and name of the PDF file.
Clicking Save completes the process.
Do not select the File option from the Destination menu. PDF Creator
always prints to a PDF file. If you select this option you will create a PostScript file instead.

3.2 Convert a PostScript or Encapsulated PostScript file to PDF
Jaws PDF Creator can convert PostScript language or EPS (Encapsulated PostScript) files to PDF.
When Jaws PDF Creator is installed a desktop icon called Jaws ToPDF is created.
Windows: Drag the PostScript language or EPS file from your Explorer
window onto the Jaws ToPDF short-cut on your desktop. Alternatively,
right-click on the file. If it has a .ps, .eps or .prn extension, select Send
To> and then Convert To PDF.
MacOS: Drag the PostScript or EPS file onto the Jaws ToPDF application.
Alternatively, select the document in the Finder, control-click to open the
contextual menu and select Convert To PDF.
The location of the PDF file is the same folder as the source. The progress of the
PDF file creation is indicated by a progress dialog.

8
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3.3 Create a PDF file containing bookmarks and links
PDF Creator includes an implementation of the PostScript pdfmark operator,
which is used to create PDF annotations, that are compatible with Adobe Acrobat
Distiller. Some applications, such as FrameMaker®, directly support the generation of Acrobat annotations. Others may require the use of special macro packages or hand-made EPS files. In each case, any method of generating annotations
that works with Distiller also works with PDF Creator.
The pdfmark operator is documented in Adobe Technical Note number 5150,
which is freely available from their web site.

3.4 Create a PDF file using a custom page size
If you are generating a PDF file intended mainly for on screen viewing, you may
want to generate it with an unusual page size, so that it fits more neatly onto the
screen. The PostScript compatible interpreter in PDF Creator can accept any page
size specified via the setpagedevice operator.
MacOS: Choose Custom Page Sizes from the LaserWriter 8 Page Setup
dialog that appears when you choose Page Setup... from any application.
Windows: There are two ways to achieve this:
1. The first solution avoids this problem, and lets you print to a standard page
size instead. A PDF file actually contains two boxes for each page: the
MediaBox is the notional paper size, and the optional CropBox is the size to
which the page content is cropped. Acrobat Reader always uses the
CropBox, if it is present, as the size of the page it displays on screen. If your
application is able to generate pdfmark code, you may be able to set the
CropBox for the pages you generate.
2. Otherwise, you have to generate a PostScript file that asks the printer to use
the custom page size. If you are using Windows 95, both the Microsoft and
Adobe PostScript printer drivers allow you to specify up to three custom
page sizes for a printer, from the Paper tab in the printer properties dialog. If
you are using Windows NT, the printer driver has no provision for custom
paper sizes; however, you can edit the PDF Creator PPD file with a text
editor to add the required paper sizes, which will then appear in the Printer
Properties dialog in the usual way. You should restart your computer after
editing the PPD file.
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Unless you are using Windows NT, the second solution is the easiest.

3.5 Change the name or destination folder of the PDF file
Unless you enable the Always output files to option in the General tab of the
Control Panel (see Section 5.2.6), when you print to PDF Creator from an application, PDF Creator prompts you for a destination folder for the output file. The
default destination folder is the last folder you used, and the file name is constructed from the document name provided by the application. You may change
either of these before clicking OK to save the PDF output file.
Jaws ToPDF does not prompt you for the output file name by default. Instead, the
output file is created in the same folder as the input file, and with the same name,
except for a .pdf extension. If you enable Always output files to in the General tab
of the PDF Creator Control Panel, Jaws ToPDF places the file in this folder, but
with the same name as the input file (and a .pdf extension).
MacOS: The output files are saved as a PDF file type.
If you select Always prompt for a destination from the Configure Jaws PDF
Creator dialog box in the Jaws ToPDF application window, a prompt for an
output file name appears for each file. See Section 4.4 for more information about
configuring the Jaws ToPDF application.
Windows: This setting also affects jobs converted by dropping the input
files onto the Jaws ToPDF short-cut.
When the prompt for a name and destination folder appears you can also change
the security options. For more information see Section 5.5.

3.6 Stop PDF Creator prompting for a file name
In the PDF Creator Control Panel, click the General tab and select the Always
output files to box. Then select the folder in which you want to save the PDF files.
For more information see Section 5.2.6.

10
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3.7 Produce PDF files compatible with Acrobat
PDF Creator can produce version 1.2 and 1.3 PDF files. PDF 1.2 are compatible
with Acrobat v3. PDF 1.2 and 1.3 files are compatible with Acrobat v4 (or later).
If you do experience any problems reading PDF files, download the latest version
of Acrobat Reader free from the Adobe web site. See Section 5.2.1 for more
information.

3.8 Produce files that can be sent by e-mail
To produce files that can more easily be sent by e-mail, select the General tab, in
the PDF Creator Control Panel and select the ASCII format check box. For more
information see Section 5.2.4.

3.9 Produce more compact PDF files
There are several options that have an effect on the size of the output file, all of
which are available in the Compression tab of the PDF Creator Control Panel.
The default settings after installation are designed to give the maximum lossless
compression for general use. The most important options are:
Compress text

This option applies zip compression to the PDF commands in page descriptions.

Subsetting embedded fonts
This option can help in reducing the size of the output. If
you are working in a controlled environment, choosing
not to embed some or all fonts can further reduce the size.
Image compression
Zip compression is usually the best overall compromise
setting as it is efficient and lossless.
JPEG compression
If you can tolerate lossy compression, that is, compression
that throws some of the data away never to be retrieved,
you can use JPEG compression.
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Zip with Predictor
You may find that Predictor compression sometimes
improves the performance on images where there are lots
of similarly colored pixels.
Note: The terms Zip and Flate are interchangeable; they both refer to the same
kind of compression.
Advanced users can also tailor the parameters used by JPEG compression.
Windows: These are in the file default\startup.ps in the PDF Creator
folder.
MacOS: These are in the file default:startup.ps in the Jaws PDF Creator
Resources folder in your Extensions folder.

3.10 Launch Acrobat Reader to view the file when complete
Jaws PDF Creator can automatically launch any application on successful completion of a job. For details on how to set this option, see Section 5.2.6.

3.11 Change the author name in the PDF file
The author name is the name that appears in Acrobat Reader if you select File >
Document Info > General. The author name that PDF Creator places in the Info
dictionary of a PDF file is a combination of the current user name and the computer name. If the computer is not on a network, PDF Creator uses the name and
company you entered during installation. See Section A.2.4.2 for more
information.
Windows: It is possible to change this by editing the file
default\prologue.ps in the Jaws PDF Creator folder.
MacOS: It is possible to change this by editing the file
default:prologue.ps in the Jaws PDF Creator Resources folder in your
Extensions folder.
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If you edit this file with a text editor, you will see the following lines:
%%%%%
% Here’s how to change the Creator in the DocInfo structure.
% Watch the ’:’ !
% (: YourNameHere) DoAuthor

Change YourNameHere to the text you would like, and remove the % from the
beginning of the line. PDF Creator uses this for the author name.
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4 JAWS TOPDF – CONVERTING FILES TO PDF
Jaws ToPDF is a front end to PDF Creator that lets you treat it as a stand-alone
application, similar to Acrobat Distiller. This allows you to convert existing PostScript language or EPS files to PDF.
Windows: You cannot convert existing PostScript or EPS files by printing
files to PDF Creator using the printer port. For more information about the
Windows printer port see Section A.1.1.
Jaws ToPDF can accept PostScript language and EPS files including EPS with
previews.
If Jaws ToPDF does not recognize a file format, it generates a warning before
processing.
Windows: There are two ways in which you can use Jaws ToPDF; as a dragand-drop target or as an application.
MacOS: You can drop a file on the application icon or on the open application window, or select a file using the Open... option from the File menu.

4.1 Jaws ToPDF drag-and-drop - Windows
If you have installed a desktop short-cut, you can use Jaws ToPDF as a drag-anddrop target. You can drag files onto the desktop short-cut to convert them to PDF.
By default, the PDF file has the same name and is created in the same folder as the
original file, except that it has a .pdf file extension. While each file is being converted, a small progress window appears:

Note: If the destination file name already exists in that location, and the
Overwrite an existing PDF file option is not selected, a unique number is appended

to the file name. See Section 5.2 for more information.
An example of a name is: BOOK.pdf, BOOK0.pdf, BOOK1.pdf.
14
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4.2 Jaws ToPDF application – Windows
You can run Jaws ToPDF as an application, by double-clicking the short-cut on
the desktop or by selecting Start > Programs > Jaws Systems > Jaws ToPDF. In this
case, a larger application window is displayed.
You can drag-and-drop files onto the application window. You can also convert
files by using the File > Open... option which displays a file browser allowing selection of the files to be converted.

When you have converted all the files you want, click Done to exit the
application.
While drag-and-drop from Explorer works with both the desktop short-cut and
the application window, drag-and-drop from the File Manager only works with
the Jaws ToPDF application window.

4.3 Jaws ToPDF application – MacOS
Under the Macintosh operating system dropping a file on the application icon;
choosing Open... from the File menu; and dropping a file on the open application
window; all result in the file being converted to PDF.
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When a file is being converted its progress is indicated:

Note: If the destination file name already exists in this location, and the Overwrite
an existing PDF file option is not selected, a unique number is appended to the file
name. See Section 5.2 for more information.
An example of a name is: Book.pdf, Book 1.pdf, Book 2.pdf.

4.4 Jaws ToPDF Configuration
With the Jaws ToPDF application open use the Settings > Configure... option to
open the Configure Jaws PDF Creator dialog.

Three standard configurations are provided from the menu: Press Ready, Print
Quality and Web. For more information on these options see Section 5.1.
Any custom configurations you have created also appear in this menu.
Windows: Use the Edit Configurations button to display the PDF Creator
Control Panel, where additional configurations can be defined.
MacOS: Use the Open Control Panel button to display the PDF Creator
Control Panel, where additional configurations can be defined.
For more information on how to create a custom configuration see Section 5.1.
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Jaws ToPDF can be configured to either; prompt for an output file name, or to
save the file in the default output folder.
When you select Always prompt for a destination, a PDF Creator browser dialog is
displayed every time you convert a file. This allows you to change the output file
name or place it in a different folder.
If you select Do not prompt for a destination Jaws ToPDF silently outputs the PDF
file to the default output folder. Although you can only change this setting from
the Jaws ToPDF application window, it also affects any jobs which are converted
by being dropped onto the desktop icon or short-cut.
Whether or not you ask Jaws ToPDF to prompt for a destination, it calculates the
default output folder in the same way. This is the same folder as the input file,
unless you have set the Always output files to option in the General tab in the PDF
Creator Control Panel, in which case it is the folder you have specified. See
Section 5.2 for more information about the General tab in the PDF Creator
Control Panel.
If you have configured Jaws ToPDF not to prompt for a destination, this is the
folder that is actually used; if you have asked Jaws ToPDF to prompt you, the
browser dialog still allows you to change the output folder.
When you convert an EPS file, Jaws ToPDF uses the bounding box in the file to
determine the page size for the PDF file, and ignores the currently selected Use
%%BoundingBox for option. See Section 5.2.7 for more information.
When the configuration for the Jaws ToPDF application is completed select OK.
Selecting Cancel aborts the changes made to the configuration.
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5 CONTROL PANEL REFERENCE
This section describes all the options available in the Configure Jaws PDF Creator
Control Panel.
Note: The first three dialogs in this section are from the Windows version and the
last three are from the MacOS version.
Use the following options to open the Configure Jaws PDF Creator Control Panel.
Windows: Select Start > Settings > Control Panel and then double-click the
Jaws PDF Creator icon.
MacOS: Select Apple Menu > Control Panels > Jaws PDF Creator.
From the Jaws ToPDF application window select Settings > Configure followed by clicking the Open Control Panel button.
The PDF Creator Control Panel has a number of tabs for different tasks. Click the
various tabs to access and change the information contained under that heading.
The following sections describe the options contained within each tab.

18
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5.1 Settings tab
Typically, the options in this tab are the most frequently changed. You can choose
the default configuration that PDF Creator will use to create PDF files.

The menu in the Current Configuration section contains the name of the default
configuration.
Windows: If you want to use a different configuration, choose another
name from the menu and click the OK button.
MacOS: If you want to use a different configuration, choose another name
from the menu. This new selection is immediately available (you do not
have to close the dialog).
PDF Creator is supplied with three standard configurations that are suitable for
most uses:
Press Ready

Optimized for sending jobs to a commercial printer at
2400 dpi (dots per inch).
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Print Quality

Optimized for printing to office type laser printers at 600
dpi.

Web

Optimized for screen viewing and for use in web pages at
72dpi.

As each option is selected, notice that the window below contains a brief description of that option.
If none of the existing configurations are appropriate, you may create a new one.
Windows: Use the Add or Duplicate buttons. Add creates a configuration
with the default settings. Duplicate copies the settings from the currently
selected configuration.
MacOS: Select the configuration which most closely matches your intended
new configuration and click Duplicate.
Although a unique name for the configuration is generated automatically, you
may want to change the name and description to reflect the intended use.
If you want to make changes to an existing configuration, select it from the menu
then make the desired changes to the other tabs.
Windows: Your changes become effective when you click either the OK or
the Apply button.
Clicking OK accepts the changes and closes the Control Panel. Clicking
Apply accepts the changes but leaves the Control Panel open. Clicking
Cancel aborts any recent changes and closes the Control Panel.
MacOS: New options are immediately available (you do not have to close
the dialog). To abort recent changes use the Edit > Undo menu option.
You may change the name or description of an existing configuration by selecting
it and clicking the Rename button. You may remove a configuration by selecting it
from the list and clicking the Remove button.
The standard configurations that are shipped with PDF Creator may not be
renamed or removed, therefore these buttons are disabled when a standard configuration is selected from the menu.

20

Jaws PDF Creator 2.1: issue date January 2002

5

Control Panel reference

The standard configurations cannot be modified (they are read-only). If you do
make changes to a standard configuration, you are prompted to save the modified
configuration with a new name.
Windows: A configuration name can contain any characters you wish
except for backslash (\).
Leading and trailing spaces are removed from the name. Configuration names
must be unique and are not case sensitive (that is, ConfigName and configNAME
are considered to be the same).

5.1.1 Font management
Windows: Click the Font Management button in the Settings tab.
MacOS: Click the File > Manage Fonts option. Macintosh format fonts are
supported.
This dialog allows you to control which fonts are installed and available to the
PDF Creator printer. These fonts are always installed on your disk, of course, but
you can control whether or not they are visible to PDF Creator, and therefore
whether or not they can be loaded by the PostScript findfont operator.
This dialog lets you manage both Type 1 fonts (also known as ATM fonts or PFB
format fonts) and TrueType fonts. Each kind of font is distinguished by an icon in
the margin.
This option makes no distinction between PFB format, PFA format (an ASCII
format for Type 1 fonts typically used on UNIX platforms), or raw PostScript files
containing Type 3 fonts. All of these fonts are displayed as PostScript fonts in this
dialog, and all may be successfully installed for use with PDF Creator.
Windows: The core fonts that are installed with PDF Creator are listed in
red and may not be removed.
MacOS: The core fonts that are installed with PDF Creator cannot be
removed and are indicated with a “lock” icon.
The core font set includes clones of the 35 standard PostScript printer fonts, as
well as stub files which refer to them. For example, Helvetica is one of the standard fonts, but the font file for Helvetica is just a stub that substitutes the clone
font Helsinki instead.
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The reasons for wanting to make the fonts visible to PDF Creator differ for the
two formats.
The principal reason for installing Type 1 fonts is if you are using Jaws ToPDF to
convert files which do not contain embedded fonts – for example, if they were created on a different machine. If you try to convert such files without making the
fonts available to PDF Creator, the document is converted with incorrect text metrics. By making the fonts you need available to PDF Creator, the document is converted with all the correct fonts and spacing.
If you add a Type 1 font to PDF Creator because it is used but not embedded in a
PostScript language file, remember that it is not embedded in the PDF output files
unless you also add it to the Always Embed list in the Font embedding tab. See
Section 5.4 for more information.
Windows: The main reason for installing TrueType fonts is so they can be
used with the TrueType substitution feature, described in Section A.2.2.3.
For any bitmap or outline font to be a candidate for TrueType substitution,
the original TrueType font must be installed. By default, PDF Creator
searches for and installs all TrueType fonts in your Windows directory when
it is first installed. However, if you subsequently add any new TrueType
fonts to your system, you must manually make them available to PDF
Creator using the Font Management options.
Clicking the Select Folder button displays a browser dialog, allowing you to select
the folder where PDF Creator can find the fonts you want to add.
The System Fonts button is a short-cut, equivalent to opening the fonts folder.

5.1.2 About Jaws PDF Creator
This option displays useful information about your version of Jaws PDF Creator.
Windows: Click the About Jaws PDF Creator button to determine the version of the software you are using.
MacOS: Access the About Jaws PDF Creator option from the Apple menu.
Version

22
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Kernel build

This is a unique identification of the version of PDF
Creator that you are using, and should be included on all
bug reports that you submit.

Serial No.

This is the Serial number you entered when installing the
registered version of PDF Creator. You need this if you
wish to report bugs or otherwise require support. If you
installed a demonstration version of PDF Creator, this will
read Demonstration version.

Debugging mode
Selecting this box causes PDF Creator to generate a verbose log describing its progress through the document.
You may be asked to provide this information after you
have filed a bug report. Otherwise, you should leave this
disabled. Once you have generated the requested debug
log you must remember to switch off Debugging Mode
otherwise the debug file continues to grow in size with
every job distilled until your hard disk is full.
MacOS: Debugging mode is hidden.
The Enter Serial Number option is used to license your version of Jaws PDF
Creator. For more information see Section 2.3.
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5.2 General tab
This tab provides options to configure the type of PDF file, the location for the file
and the actions to perform when the PDF has been created.

5.2.1 PDF file format
Use this option to create either PDF v1.2 or PDF v1.3 files. PDF v1.2 files are
compatible with Acrobat Reader version 3.0. PDF v1.2 and v1.3 files are compatible with Acrobat Reader version 4.0.
If you do experience any problems reading PDF files you should download the
latest version of Acrobat Reader free from the Adobe web site.

5.2.2 Thumbnail generation
PDF Creator can optionally generate thumbnail images of each page (either
monochrome or color), which can be used as a navigation aid in Acrobat Reader.

24

Jaws PDF Creator 2.1: issue date January 2002

5

Control Panel reference

5.2.3 Resolution
This option allows you to change the effective resolution at which the PostScript
language job is rendered. This only affects jobs which contain resolution-dependent (and therefore device-dependent) code. If your job contains pattern fills, the
printer driver attempts to snap the pattern frequency to a sub-multiple of the
device resolution. Some drawing packages also use the resolution (in conjunction
with the halftone frequency) to calculate the number of steps to use for graduated
fills. All other page elements should be unaffected by the resolution.
If the PDF file is intended for printing, you should set the resolution to be the
same as the resolution of the intended final output device; otherwise, you should
only change the resolution if you experience poor-quality output with pages containing patterns or graduated fills.

5.2.4 ASCII format
If this option is selected, any binary data (including compressed text) in the PDF
file is converted to a printable ASCII representation. This makes it safe to transmit
your PDF pages over a medium that does not support binary transmission (internet e-mail for example). Using ASCII format will increase the size of your PDF
file.

5.2.5 Auto-rotate pages
PDF Creator will always honor requests for landscape output, however some
Windows applications will produce landscape output by rotating the output onto
a portrait page. When printed, this is not a problem, as the page can easily be
rotated. However, when producing a PDF this leads to text running up the screen.
If Auto-rotate Page is checked, PDF Creator will look for, and act on, the
"%%ViewingOrientation" DSC comment in the incoming PostScript job. The
%%ViewingOrientation comment explicitly specifies how to rotate the page from
its default orientation so that the PDF is produced at its optimum viewing
orientation.
The %%ViewingOrientation DSC comment is inserted into the job by the application generating the PostScript files and/or the printer driver. Not all applications and drivers generate this comment.
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If %%ViewingOrientation is present in a job, it will be used otherwise PDF Creator will attempt to determine the orientation of the majority of the text on the
page, and rotate the page until this text is upright. PDF Creator does this by looking at the text baseline and making it travel from left to right, so it gets the result
wrong if most or all of the text on the page is mirrored.
For more information on rotation see, ’Rotation and applications and drivers that
do not generate %%ViewingOrientation’ in the Troubleshooting section.

5.2.6 Output options
These options control what to do with the PDF when it has been created.
Always output files to
If this box is checked, PDF Creator does not prompt you for a destination file
name, but outputs all PDF files to the specified destination folder. The file name is
composed of the document name (with a numerical suffix, if necessary to avoid
duplicate file names). This feature is mainly of use when using PDF Creator to
generate all files in a single location. In this case, you should also make sure that
you do not have Display Messages enabled in the Reporting tab, described in
Section 5.6.1.
Note: The numeric suffix generation can be defeated using the Overwrite an
existing PDF file option. See later in this section for more information
Windows: Select the option then either enter the full path or use the Browse
option to select the required folder.
MacOS: When you select this option a Select Folder dialog box appears
allowing you choose the required folder. If a folder has previously been
selected use the Change button to choose a new location.
Execute on job completion – Windows
Launch application on job completion – MacOS
You can select an application, which PDF Creator executes each time a job is successfully converted to PDF.
Windows: Select the option then either enter the full path or use the Browse
option to select the required application.
26
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If you wish, you can use the string %s as a place marker in this command
line – it is replaced by the actual name of the PDF file. If you use Browse to
locate the application to run, a %s is appended to the command line for
you.
Note: The %s place marker should be surrounded by double-quotes if there
is any possibility that the generated PDF file will be written to a file name
where any component of the path contains a space.
For example:
C:\myapp\myapp.exe -x -p "%s"

MacOS: When you click Browse a Directory dialog box appears allowing
you to select the required application.
PDF Creator sends the nominated application an Open Document
AppleEvent. If the application is not already running, it will be launched.
Within the Jaws PDF Creator:Scripts folder two scripts are available for
selection. The scripts Create Eudora Message and Create Outlook
Message open the respective applications with the previously generated PDF
selected as an attachment.
View the PDF file after creation
Select this option to automatically open your generated PDF file using the systemregistered PDF viewer application (usually Adobe Acrobat). If a viewer application is not installed, nothing will happen.
Send the PDF file as an e-mail attachment
This option will cause the active mail application to display a Send mail dialog
with the generated PDF already included as an attachment.
MacOS: To send a PDF as an e-mail attachment under MacOS use the
Launch application on job completion option see above.
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Overwrite an existing PDF file
With this option selected PDF files with the same name as an existing file overwrite the existing file rather than create a file name with an increment. This
option only applies when the Do not prompt for a destination option is selected. If
Always prompt for a destination is selected you always have the choice of overwriting or creating a new name.

5.2.7 Advanced button
Click the Advanced button to access extra configuration options.
As with Acrobat Distiller, PDF Creator allows you to apply different processing to
full color, grayscale, or monochrome (bitmap) images.
Transfer functions
This menu provides the option of preserving, applying or removing transfer functions from the PostScript language file. If you select the Apply option, the document is displayed the same on-screen as when printed.
Convert CMYK to RGB
This option only applies to color images. If it is enabled, any four-color CMYK
images in the PostScript language input file are converted to RGB images in the
PDF output. This can result in a smaller PDF file that displays more quickly. You
should enable this if your documents are intended for on-screen viewing, and disable it if they are intended for printing.
Enabling this option can cause an apparent color shift in the images to which it is
applied. The conversion that PDF Creator uses is better suited to photographic
images than to CMYK approximations of spot colors. You may find that onscreen reproduction of some graduated fills and tinted images is better with this
option disabled than with it enabled.
Convert device independent colors to device dependent colors
With this option selected, PDF Creator converts colors specified in device-independent CIE-based color spaces into device-dependent RGB. This produces PDF
files which display more quickly. Otherwise, these colors are converted into a
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device-independent calibrated RGB color space. This produces PDF files which
render more slowly, but whose colors are more constant across properly set up
output devices.
Preserve halftones
With this option selected, any halftone changes requested by the job are passed
through to the PDF file. You should select this option when producing PDF files
for print, and disable it when producing PDF files for on-screen viewing.
Preserve overprint
With this option selected, any changes to the PostScript graphics state overprint
parameter requested by the job are passed though to the PDF file. This feature,
along with Preserve OPI comments, Transfer functions and Under Color Removal
and Black Generation Information is intended primarily for use within a pre-press
environment.
Preserve under color removal and black generation information
This option allows you to preserve or remove under-color removal and black-generation information from the PostScript language file. This is normally only used
in pre-press environments.
Use %%BoundingBox for
As well as the conventional page size request embedded in the PostScript language
file, many files also contain comments describing the actual extent of marks on
the page. The Use %%BoundingBox for option lets you: ignore these comments –
by selecting Nothing; use the bounding box for the PDF page size – by selecting
Page Size; or use the bounding box for the optional page cropping box – by selecting Crop box.
Acrobat Reader always displays pages as if they were the size specified for the
page cropping box. Some applications may generate their own cropping box
information using pdfmark, which overrides any cropping box set in this way.
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Preserve OPI comments
OPI (Open Prepress Interface) is used to reduce network traffic by substituting
high-resolution images with low-resolution screen images for the purpose of
screen display and page make-up.
With this option selected, OPI comments in the PostScript language input file are
reproduced as OPI dictionaries in the PDF output.
It is not necessary for the high-resolution image data to be available to PDF
Creator – it passes the file name through to the output. PDF Creator produces
only an OPI 1.3 dictionary, only an OPI 2 dictionary, or both, depending on
whether the PostScript language file input uses one or both versions of the OPI
comments.

5.3 Compression tab
The three panels under the Compression tab allow different compression techniques to be applied to different types of image.
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5.3.1 Downsample
The Downsample options allow you to control whether and how PDF Creator
reduces the resolution of images in the PostScript language file input.
You should set this to Don’t downsample if your documents are intended for
printing.
Subsample reduces the resolution of the image by dropping pixels.
Average reduces the size by averaging neighboring pixels and produces good

quality results. You cannot average a monochrome image in PDF Creator – unlike
Acrobat Distiller, PDF Creator does not “promote” such images to grayscale.
Bicubic reduces the resolution by performing bicubic interpolation to generate

new pixel values. This option can generate more pleasing results though the PDF
will be slower to generate. Bicubic is not available with monochrome images.

5.3.2 Compression
There are three compression filters available for dealing with images. The Zip
filter uses a lossless compression technique and normally produces good compression ratios. It can optionally apply a predictor algorithm which can further
improve the compression for some classes of image.
The JPEG filter uses a lossy algorithm (which irretrievably discards data), but it
produces excellent compression ratios on photographic images. You can optionally modify some of the JPEG compression parameters by editing the file
startup.ps, as described in Section A.2.4.1.
The CCITT filter uses standard fax compression, and is only applicable to bitmap
images. You can control the selection of group 3 or group 4 fax compression in
startup.ps see Section A.2.4.1.

5.3.3 Resolution
If you have enabled downsampling, this option lets you specify the target resolution of the reduced images actually embedded in the PDF file.

5.3.4 Compress text
If this is selected, PDF Creator compresses textual information, such as page
descriptions, using Zip compression.
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5.4 Font embedding tab

5.4.1 Always embed
Fonts listed in this box are always embedded in the output PDF file. Use the Add
and Remove buttons to manage this list. You should check the terms of your font
license agreement before embedding any fonts. Named fonts will be embedded if
they are referenced in the original PostScript language file and are available to
PDF Creator.

5.4.2 Never embed
Fonts listed in this box are never embedded in the output PDF file. Use the Add
and Remove buttons to manage this list.

5.4.3 Embed all fonts (except base 14 fonts)
When this option is selected, all fonts present in the document (except base 14
fonts) are embedded in the output PDF file. With this option selected, all fonts
that were embedded in the PostScript language file (by the printer driver or generating application) will be embedded. If a font is referenced by the incoming PostScript file and is available to PDF Creator, it will be embedded in generated PDF
file.
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If this option is not selected, the font will only be embedded if it is named in the Always
embed list.

Any candidate for embedding is rejected if either it is one of the base 14 PDF
fonts, or it appears in the Never embed list.

5.4.4 Embed base 14 fonts
If this is selected, all base 14 fonts present in the document are embedded in the
output PDF file. Selecting this option implicitly adds the base 14 fonts to the
Always embed list.

5.4.5 Subset fonts
With this option selected, only subsets of the original fonts are embedded in the
PDF file. This is the preferred setting, as it leads to smaller files. However, selecting Subset fonts prevents you from subsequently using Acrobat plug-ins or other
tools that allow text editing within a PDF file, as not all characters from the
embedded fonts are available for use.

5.4.6 Use original TrueType fonts – Windows
The Windows PostScript printer driver replaces TrueType fonts with bitmaps and
unhinted outlines. If this feature is selected, PDF Creator will attempt to substitute
the fonts generated by the printer driver with the original TrueType font. This
substitution is discussed in detail in Section A.2.2.3.
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5.5 Security tab
The options under the Security tab provide various levels of protection for your
PDF documents.

5.5.1 Encrypt PDF files
Select this option to encrypt the PDF files created by PDF Creator. This option is,
as a default, not selected. When selected, all other options within this tab become
available.

5.5.2 Passwords
You can apply security to PDF files by entering passwords and restricting selected
features, such as editing and printing. A PDF file can have both an Open document password and a Change security password.
If both passwords are applied, the document can be opened using either one.
When the correct Open document password is provided, the document is opened
and decrypted. However, use of the document is limited by whatever restrictions
have been specified in the Do Not Permit Users to section of the dialog.
The Change security password allows the user to open the PDF and modify the
security settings.
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When a file is opened with a Change security password, you have unrestricted
access to the document. in effect, the security restrictions are temporarily disabled.
If you wish to limit access to your file, you should apply a Change security password, otherwise anyone who opens the file is able to remove the restrictions.
It is important to note that Acrobat will not prompt for a password if no Open
document password is entered when creating a secured PDF. This means that
when only a Change security password is used, the document is opened without
the user having to provide a password, and use of the file is limited by whatever
security restrictions have been imposed. As a result, if the user has only the free
version of Acrobat, they are never able to obtain unrestricted access to the
document.

5.5.3 Do not permit users to
Each option selected in this panel restricts the ability of the user. Deselect the functions if you want to allow user access.

5.6 Reporting tab
This tab allows you to control what happens to messages generated by the PostScript language compatible interpreter.
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5.6.1 Display messages
With this option selected, PDF Creator displays all messages generated by the
interpreter in an on-screen message box. This is useful for debugging. You should
not leave this option permanently enabled, as the PostScript printer drivers normally cause messages to be generated continuously – for a serial printer, this
allows tracking of the job, but viewing each message individually can become
quite tedious.

5.6.2 Only log errors
With this option checked only error messages are written to the log file – normal
progress and user messages continue to be displayed (if that option has been
selected) but are not written to the log file.

5.6.3 Discard messages
If this is enabled, all messages from the interpreter are discarded. This is of use in
a batch environment. When enabled, this also causes all error messages to be discarded, so you should use it with caution.

5.6.4 Create individual log files for each job
If this is enabled, PDF Creator creates an individual log file for each job, and
writes messages generated by that job to its log file. The log file is created in the
same folder as the PDF file, and with the same name, but with a .log extension. It
may be viewed with a text editor. If the messages are merely informative, the log
file is created in addition to the PDF output file. If an error occurs, the PDF file is
not created, and the log file contains the relevant error messages.

5.6.5 Log all messages to
With this option selected, the messages generated by all jobs are collected in a
single log file. The location and name of the log file can be entered into the text
box. Alternatively, use the browser to choose the location of the log file.
Windows: Select the option then: select the path displayed; enter a new path
or use the Browse option to select a new location and name.
MacOS: When you select this option a Directory dialog box appears allowing you choose the required name and location.
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6 MICROSOFT WORD MACRO - WINDOWS
Jaws PDF Creator treats Microsoft Word as a special case. When PDF Creator is
installed on Windows platforms it creates a macro for Word97 and Word2000
applications. This macro allows Word users to print directly to PDF Creator.
To create a PDF from Word, select Jaws PDF Creator > Create PDF File from the
File menu. A Jaws PDF Creator working message appears followed by a Create
PDF Browser dialog that allows selection of the location and name of the PDF
file. This dialog also allows selection of the various security options that can be
applied to a PDF file. These security options are the same as the options provided
within the PDF Creator Control Panel. See Section 5.5 for more information.

6.1 Word macro settings
You can change the settings for PDF Creator from within Word. Select Jaws PDF
Creator > Settings... from the File menu. The PDF Creator Configuration has a
number of tabs for different tasks. Click the various tabs to access and change the
information contained under that heading. The following sections describe the
options contained within each tab.

6.1.1 General tab

All the Create PDF... options are selected as a default and should generally be left
selected. If required, you can deselect any of these options.
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Select the Automatically open the generated .PDF file option to automatically open
in Acrobat every PDF file created from the Word macro. The setting of this option
will override the setting of View the PDF file after creation option in the General
tab of the PDF Creator Control Panel. For more information see Section 5.2.
Select Prompt for the location of the output .PDF file to display a browser allowing
you to change the location and name of every PDF file generated from the Word
macro.
You may want to use Acrobat as a previewer before sending your job to a PostScript RIP for outputting on an imagesetter or printer. In this case, select the Keep
the intermediate PostScript (.PS) file after .PDF creation option. This keeps the
PostScript file, which is created before the PDF, so that you can use it for other
processes.
Selecting the Send the generated PDF file as an email attachment option will cause
the active mail application to display a Send mail dialog with the generated PDF
already included as an attachment.

6.1.2 Document tab

The options in the Open Options panel let you configure how you would like
Acrobat to display the generated PDF. There are various view options, magnifications and even selection of the document page number. All these options can be
changed once the PDF is viewed within Acrobat.
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Selecting Allow editing of document information prior to converting each document
displays the following dialog every time a file is converted to PDF:

Enter information in each text box of the dialog and click OK.
The Convert document bookmarks into .PDF named destinations option converts
Word bookmarks into named destinations within the PDF. This provides direct
access to those topics using the Window > Show Bookmarks options within
Acrobat.
Selecting the Include hidden text option allows you to create a PDF which includes
any text designated as hidden within Word. Normally, hidden text does not
appear in the PDF file. As a default this option is not selected.

6.1.3 Links tab

The options in the Hyperlinks to Process panel control which hyperlinks within
your Word document are turned into links within the generated PDF file.
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Use the options in the PDF Link Appearance panel to configure how the links
appear in the generated PDF file.

6.1.4 Bookmarks tab

The Automatically open bookmarks in the .PDF document to depth setting in this
tab collapses or expands the document headings when the PDF is opened.
The Destination magnification option decides the zoom value when the PDF file is
opened. A number of Fit page to... options are provided. The Inherit zoom option
opens the PDF with the zoom value currently selected in Acrobat.
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6.1.5 Comments tab

If your Word document contains comments, PDF Creator lets you convert those
comments into “sticky notes” type comments in the created PDF file.
Using the Reviewer menu to select the name of each reviewer. For each reviewer
selected you can choose whether to automatically include the comments by that
reviewer, whether to display those comments open in the generated PDF file and
to select a color for any included comments.
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6.1.6 About tab

This tab provides useful contact and version information.
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7 TROUBLESHOOTING
The application I’m printing from goes blank when I print to PDF Creator
Only applicable to Windows – the printing application is suspended waiting for
you to select a destination. During this time, it can't respond to repaint messages
from Windows. This is harmless.
Acrobat Reader displays text as bullets
This is normally a problem with Acrobat incorrectly calculating the size of text
displayed when using an embedded TrueType font. In Acrobat Reader’s File >
Preferences > General dialog, deselect the box labelled Greek text below... pixels.
Acrobat Reader does not display some text
There are some undocumented restrictions on the commands which Acrobat
Reader accepts in embedded CFF fonts (PDF Creator uses the CFF format for all
embedded Type 1 fonts; you can find out the type of fonts used in your documents
using the menu option File > Document Info > Fonts dialog in Acrobat Reader.)
Where the PDF file produced by PDF Creator contains such unsupported commands, Acrobat Reader displays some characters in the font concerned as blanks.
Please submit a bug report if you find such a font.
Acrobat Reader v3 displays PDF with missing “c” and “K” characters
There is a problem with Acrobat Reader for Windows that occasionally results in
the characters “c” and “K” being omitted from the display. This happens if the
PostScript file is generated by the Microsoft printer driver. This is not a bug with
PDF Creator. The workaround is to upgrade the version of Acrobat from v3 to v4
(or later).
Acrobat Reader displays an “unable to extract font” message
This is a TrueType font that has been downloaded as outlines using the Adobe
PostScript driver: Select the Font Embedding tab of the PDF Creator Control
Panel, and select Use original TrueType fonts. If this does not help, you need to
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click the Font management button of the Settings tab and click the Select Folder
button to find the TrueType font.Add it to the PDF Creator list of fonts, and try
again.
Text in some fonts is garbled
Only applicable to Windows: PDF Creator is probably re-encoding a TrueType
font which it should not be, or not re-encoding a font which it should be. You can
control this by editing the font tables in default\startup.ps in the PDF Creator
folder. These are described in Section A.2.4.1.
Alternatively, you may be using Jaws ToPDF to convert a file (with TrueType substitution enabled) which originated on a different operating system.
Text which should be outlined is displayed as solid
This appears to be a problem with the way Acrobat Reader displays certain Type
3 fonts. The document prints to a PostScript language-compatible printer
correctly.
Text appears jagged
This means that a TrueType font, downloaded by the printer driver as a bitmap or
an outline font, has not been substituted back into the PDF file by PDF Creator.
Check that you have enabled TrueType substitution, and that the original font is
known to PDF Creator, in the PDF Creator Control Panel. If you are using Windows 95, make sure that you are using the Microsoft printer driver, version 4.0,
and not an Adobe driver, version 4.1 or 4.2. If you are using Windows NT, you
may need to add the font to the tables in default\startup.ps.
Bitmaps which should be transparent mask the background color
Acrobat Reader sometimes has problems displaying large bitmap masks, displaying them as opaque images instead. Use the Acrobat Reader menu option File >
Preferences > General to open the General Preferences dialog, and unselect the
Smooth Text and Images check box.
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Invalidaccess error with setdistillerparams
The setdistillerparams operator is the way that PDF settings are controlled
from within a PostScript language file. PDF Creator supports mostly the same set
of parameters that Acrobat Distiller supports, although there are some extra
parameters for PDF Creator (which are used by the PDF Creator Control Panel),
as well as some Distiller parameters which do not make sense for PDF Creator.
In particular, PDF Creator does not support LZW compression. This is only
required when producing PDF 1.0 or 1.1 format files, which PDF Creator does
not support. It is not possible to select LZW compression from the PDF Creator
Control Panel; you only ever see this message if you attempt to distill a PostScript
language file which explicitly requests LZW using the setdistillerparams
operator. If so, you should amend the PostScript language file to request Zip compression instead.
In addition to this, if an error:
%%[Error: invalidaccess; OffendingCommand: filter ]%%

is encountered, it is usually because a PostScript job is explicitly attempting to use
either the LZWEncode or LZWDecode filter. This may happen if you attempt to convert to PDF a PostScript file that was produced by printing a PDF from Acrobat
Reader. If this error does appear, you must find an alternative method of producing the PostScript file that does not make use of LZW compression.
Color documents produce grayscale PDF files on Windows NT
This is due to an interaction between the Windows NT PostScript printer driver
and certain applications. An application can poll the printer driver to see if it is for
a color device or not. Some applications do this, and generate monochrome PostScript language output if a monochrome printer driver is detected. When printing
to a monochrome printer this produces a smaller PostScript language file which
prints more quickly. However, if your default printer is monochrome, and in Print
Setup... you subsequently switch to a color printer, this setting is not updated, and
the application still believes that it is printing to a monochrome device. This
results in monochrome PDF files being produced by PDF Creator, because it is
being given monochrome PostScript language input files.
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To fix this, click on Properties... in the Print Setup... dialog to display the Document Properties dialog. In the Page Setup tab, click on Color under Color
Appearance. This ensures that the application knows it is printing to a color
device.
Colors in the PDF file do not match original colors
If you have enabled Convert CMYK to RGB under the Advanced button in the
General tab in the PDF Creator Control Panel, you may find that the color reproduction of some images is compromised. There is no universal way to convert
CMYK images to RGB for on-screen viewing. The algorithm that PDF Creator
uses for this conversion has been tuned to work well with photographic images.
This means that it may not work so well for tinted images or graduated fills where
the CMYK color contains a large black component. If this happens, you should
deselect the Convert CMYK to RGB option. This results in slightly larger PDF files,
but should have no other side effects.
Internet Explorer 4.01 “locks up” when printing
This appears to be a problem with earlier versions of Internet Explorer 4 (Windows only). Later versions do successfully print to PDF Creator on Windows 95,
98 and NT. If you experience this problem you should upgrade your version of
Internet Explorer.
Rotation and applications and drivers that do not generate
%%ViewingOrientation
For applications and drivers that do not generate %%ViewingOrientation DSC
comments a new option, called ’PageOrientation’, has been added to the printer
driver. By default PageOrientation is switched off and the auto-rotate setting in
the PDF Creator configuration is respected. There are four other options:
"Rotate by 0 degrees", "Rotate 90 degrees counter-clockwise", "Rotate 90
degrees clockwise" and "Rotate 180 degrees". These four options all switch off
auto-rotate (if it was enabled) and apply the specified rotation to the page. The
page is rotated from its default orientation. Because different applications do different things when, for example, they are asked to generate a landscape page from
a portrait page (and vice versa), some trial and error is required.
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This modification works under Windows 9x/Me and Windows 2000 and MacOS
but not Windows NT4.
Therefore this modification is not available under Windows NT4 using the
MicroSoft PostScript driver.
Blank pages disappear under Windows 95
This is due to a bug in the Microsoft Windows PostScript driver, which does not
print blank pages. An updated driver is available from Microsoft.
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8 SUPPORT
8.1 Download PDF Creator
You are able to download further copies of PDF Creator from the Support page at
www.jawspdf.com.
To download an installer you must either provide a valid serial number or legitimate e-mail information. You will then be provided with a password for the
installer.
Have the following information ready:
•

Serial number (if you have one)

•

Your name

•

Job title

•

Company name

•

Telephone number

•

E-mail address

•

Platform on which PDF Creator is going to be used

•

Language

8.2 Reporting problems
There is a FAQ section under the Support page at www.jawspdf.com.
If your problem is not covered here, you should submit a bug report.
When submitting a problem you should provide the following information:
•

Operating system (MacOS, Windows 95, 98, ME, 2000, NT)

•

Version of PDF Creator

•

Kernel build time
The kernel build time uniquely identifies the PDF Creator kernel you are
using.

•
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Class of problem (kills application/kills PDF Creator/kills Operating System/incorrect output)
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•

Detailed description of problem

•

Contact details

Support

The kernel build time is available in the About Jaws PDF Creator box:
Windows: Click the About Jaws PDF Creator button to determine the version of the software you are using.
MacOS: Access the About Jaws PDF Creator option from the Apple menu.

8.3 Registering
Jaws PDF Creator can be registered on the World-Wide-Web. Point your browser
at www.jawspdf.com and select the Support page and fill in the form. You should
have the following information ready:
•

Your name

•

Company name and address

•

E-mail address

•

Company size

•

Where PDF Creator was purchased

•

Number of copies purchased

•

The serial number supplied with the software
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9 CONTACT INFORMATION
If you need to contact Global Graphics Software Limited directly for any reason,
you can use the address and numbers below:
Global Graphics Software Limited
Barrington Hall
Barrington
Cambridge, CB2 5RG
United Kingdom
Tel: +44 (0) 1223 873 800
Fax: +44 (0) 1223 873 873
Web site: http://www.jawspdf.com
Mail regarding PDF Creator can be sent to sales@jawspdf.com.
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A.1 HOW JAWS PDF CREATOR WORKS
This section describes how PDF Creator works and how it integrates with the
operating system. The information contained here is not essential for using PDF
Creator however an understanding of the information will help you get the most
out of the product.
PDF Creator is built around a complete PostScript language-compatible interpreter in the same way as Acrobat Distiller. In the case of PDF Creator, the interpreter is called Jaws and is a clone interpreter developed for incorporation into
hardware and software products. Also, as with Distiller, the raster-based back-end
of the interpreter has been replaced with code which outputs graphical primitives
as text – in this case, the text builds up into PDF page descriptions. It is also possible to convert PostScript language files into other page description languages
using the same approach.
The PostScript language-compatible Jaws interpreter allows a number of transformations to be carried out in the interpreter pipeline, which is how PDF Creator
implements features such as TrueType font substitution.
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A.1.1 Integration with the operating system
Windows: One component of the printing system is a DLL (Dynamic Link
Library) called a “port monitor”. Normally, a port monitor takes the output
generated by the printer drivers (whether bitmaps for GDI printers, PostScript, or some other format), and is responsible for delivering the data to
the printer via a hardware port, typically a serial or parallel port, or possibly
a network interface. In PDF Creator, the port monitor communicates with a
separate process called PDFCreatorSV that contains the entire Jaws PostScript language-compatible interpreter. As far as Windows is concerned, the
PDF Creator port monitor is an interface to a real PostScript language-compatible printer. The port monitor advertises itself to the printing system as
JawsPDFCreatorPort, which appears in the list of available printer ports
alongside the more usual ports such as LPT1: and so on. Any output sent to
JawsPDFCreatorPort is passed to the PDF Creator interpreter, any output
directed to any other port is not. This also applies, to non-PostScript language output, so if you accidentally try to use a non-PostScript languagecompatible printer driver with the PDF Creator port monitor, a lot of error
messages are displayed as PDF Creator tries to interpret a stream of binary
data as if it was a stream of PostScript language.
PDFCreatorSV is started automatically by the PDF Creator port monitor
when the first job is sent to the PDF Creator port. PDFCreatorSV continues
to run, doing nothing, for up to a minute after the PDF file has been generated. If no other jobs are sent to the port in this time, the PDFCreatorSV
process automatically closes down, reducing the memory demands on the
system. PDFCreatorSV is restarted, if it is not already running, when the
next job is sent to the port monitor.
MacOS: PDF Creator implements a custom hose which allows a developer
to process the PostScript language output from the LaserWriter driver version 8.6 or later in any way.
Windows: To use any printer with Windows, it is necessary to provide a
printer driver. For PostScript language-compatible printers, this is easy, as
any one PostScript language-compatible printer driver can handle all possible PostScript language-compatible printers. Any product-specific features
of a given printer – such as which paper sizes are available – can be
described in a data file. The universal means of doing this is to issue a Post-
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Script Printer Description (PPD) file for each printer, although the Microsoft
Windows 95 driver uses SPD files instead. An SPD file is usually just a
subset of the information from the printer’s PPD file.
PDF Creator comes with its own PPD and SPD files. Most of the information in a PPD file describes the physical attributes of a printer, such as available page sizes, installed fonts, and so on. For this reason, you can often
print a file to one printer with a PPD file that nominally describes a different
printer. This is also true for PDF Creator – you should be able to print to the
PDF Creator port using any PPD file, although the PPD file that comes with
PDF Creator would generally give you the best results. As with any PostScript language- compatible printer, the more different the printer whose
PPD file you are using, the greater the risk of introducing subtle compatibility problems.
When the interpreter starts up - normally before every job is processed – it executes the file default\startup.ps. This file may contain any code that is to be
executed once for all jobs. You should only modify this file if you are capable of
writing PostScript language code. It contains the default parameter sets used by
the image compression filters, and the lists of TrueType fonts which require special handling by PDF Creator. For more information about the contents of
startup.ps see Section A.2.4.1.
In addition, the PostScript language-compatible interpreter executes the file
default\prologue.ps at the start of every job it converts. This file can contain
any PostScript language code that needs to be run for every job. An example of
this is the code that changes the contents of the document info dictionary in the
PDF output file, described above. It also executes the file default\epilogue.ps
at the end of every job. This may be used, for example, for any pdfmark calls that
you may want to apply to every job you convert. See Section A.2.4.2 for more
information on prologue.ps and Section A.2.4.3 for more on epilogue.ps.
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A.2 ADVANCED TOPICS
This section describes topics to do with file names and font embedding.

A.2.1 File names
PDF Creator has two strategies for creating the output file name, depending on
whether you are using the PDF Creator printer or are converting files with Jaws
ToPDF.
When you are printing directly to PDF Creator from an application, the document
name passed to it by the printing system is used as a starting point from which to
generate the name of the PDF output file.
Windows: If the document name contains a file extension, the extension is
removed, and if it appears to contain a path specification such as
c:\documents\, PDF Creator removes all the drive and folder names from
the path to obtain a simple file name. Lastly, PDF Creator appends a .pdf
extension to the file name.
MacOS: If the document ends with a recognized suffix (.ps or .eps) it is
removed before .pdf is appended.
This is the file name which PDF Creator offers you in the Save dialog box it normally displays for every job.
The output folder is determined by considering the following options:
•

The folder specified by the Always output files to option in the General tab
in the PDF Creator Control Panel, if selected.

•

The folder given as part of the document name, if there is one; (Windows
only).

•

The last folder to which PDF Creator wrote a PDF file.

Unless the Always output files to option is selected, PDF Creator always provides
you with the opportunity to change both the folder and the file name using a
browser dialog.
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At times, you may be surprised at the file names that PDF Creator generates in
this way. The reason for this is that the document name is not normally used by
the printing system, except in dialogs, to provide information about the status of
the job. This means that there is no official format for the document name, and
most applications make up their own rules.
Some applications, such as Microsoft Word 97, add the application name before
the document name. Some, such as Adobe PageMaker®, put the full path in the
document name. Occasionally, a document name will be too long for the application, and it truncates the name and appends an ellipsis (…). Some applications put
an asterisk (*) in the document name when a document has been modified.
MacOS: This is not applicable to Macintosh versions of these applications.
All of these can cause PDF Creator to offer a default file name that is different to
that which was expected. However, the file name that PDF Creator generates is
always legal.
Windows: When PDF Creator finds an illegal character such as a colon (:)
or backslash (\) in the file name, it replaces them with #.
MacOS: The colon (:) is the only character that is not valid in a MacOS file
name.
To rationalize document names that consist of an application's document name
with a fixed prefix or suffix, PDF Creator provides a means to remove anticipated
prefixes and suffixes from document names before it creates the output PDF filename. You can configure this by editing the DocNames.txt file, located in the PDF
Creator installation directory.
For example, if the Acme Wordpro word processor always prefixes documents
with “Acme Wordpro -”, followed by the full path name of the document you are
printing, you could add an entry to the DocNames.txt file to instruct PDF Creator
to strip “Acme Wordpro -”from the beginning of any document name it sees. To
do this, use any text editor to add a new line to the end of DocNames.txt that
reads:
SP:Acme Wordpro -

If you have an application that adds a suffix to the document name, instruct PDF
Creator to remove it by adding a line like this to the end of the DocNames.txt file:
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SS: - Acme Wordpro

The SS: and SP: directives, which must be at the start of a new line, mean Strip
Suffix and Strip Prefix respectively. PDF Creator is supplied with a DocNames.txt
file that rationalizes document names used by some common applications.
MacOS: This option is not supported under MacOS.
PDF Creator never overwrites an existing output file without prompting unless
the Overwrite an existing PDF file option in the General tab of the Control Panel is
selected.
If you have selected Always output files to from the Control Panel, and a file with
the same name already exists, PDF Creator appends a unique number to the file
name.
When you use Jaws ToPDF to convert existing files, PDF Creator uses the input
file name instead of the document name (because there is no document name) as
the basis for the output file name. PDF Creator uses the name and location of the
input file as the default destination, except that the file extension is replaced by
.pdf. If Always output files to is selected, the file is saved in this location. If not,
PDF Creator displays the browser dialog and allows you to change the output file
name.
See Section 5.2 for more information in the General tab.

A.2.2 Font embedding
PDF files are capable of containing fonts in three different formats. PDF Creator
is able to handle all three. In common with Acrobat Distiller, PDF Creator only
ever embeds fonts that were embedded in the original PostScript language file.
Fonts that were read from disk, including the base 14 PDF fonts (but not including TrueType fonts read as part of the substitution process described below), are
not embedded unless they are selected for embedding. See Section 5.4 for more
information.

A.2.2.1 Type 1 fonts
Type 1 fonts are the traditional format for hinted fonts in the PostScript language
community. Type 1 fonts are always handled in a standard way by printer drivers,
and PDF Creator can always extract them from the document and embed them in
the PDF file. PDF Creator always converts Type 1 fonts to the new CFF (Compact
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Font Format), which is a more compact way of encoding the same information.
Version 3 of Acrobat supports both the original Type 1 format and the Compact
Font Format; however, there are some undocumented restrictions in the CFF commands that Acrobat Reader understands. For this reason, you may sometimes
find that PDF Creator embeds a Type 1 font which will not display correctly on
screen, but which does print correctly from Acrobat to a PostScript language compatible printer. If you encounter such a font, you should submit a PDF Creator
bug report, which will enable us to comply better with the undocumented
restrictions.

A.2.2.2 Type 3 fonts
Type 3 fonts are the format used in the PostScript language community for
unhinted fonts (such as complex logotypes and bitmap fonts). PDF Creator does
support Type 3 fonts, and will embed them.

A.2.2.3 TrueType fonts
TrueType is an alternative format for hinted fonts, which originally evolved in the
personal computer community, rather the PostScript language community. Many
modern PostScript language compatible interpreters (including PDF Creator) are
able to handle TrueType fonts directly, but for historical reasons, PostScript
printer drivers make life more difficult.
The following paragraphs describe how the various PostScript printer drivers
handle TrueType fonts, and how PDF Creator’s TrueType font substitution works
with each of them.
TrueType fonts with the MacOS LaserWriter driver
These are the easiest to handle. The MacOS printer driver embeds TrueType fonts
in the PostScript language file as Type 42 PostScript fonts. PDF Creator can
handle these directly and embed the font in the PDF output file. This happens
regardless of whether TrueType substitution is on or off.
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TrueType fonts with the Microsoft printer drivers
The Microsoft printer drivers for both NT and Windows 95 cannot embed TrueType fonts in the PostScript language file as Type 42 fonts. Instead, the driver uses
the TrueType rasterizer in GDI to render each character as either an outline or a
bitmap, and then construct a Type 3 (or unhinted Type 1) font using these outlines
and bitmaps. The choice between outlines and bitmaps is usually determined by
the resolution of the printer and the point size of the text, although it can be modified to some extent by the Download soft fonts as... control in the printer setup. It
is important to realize that fonts embedded in a document in this way only look
their best when printed at the same resolution as the printer that was selected
when the PostScript language file was generated. At all other resolutions, the text
displays jagged edges.
In particular, these fonts do not perform well when embedded into a PDF file. To
address this problem, the PDF Creator TrueType font substitution code identifies
the original TrueType font used for the text, and embeds that font in the PDF file
instead. Both printer drivers do two things when generating PostScript language
that makes this task more difficult:
•

Firstly, they alter the name of the font. This is necessary because each font
represents the output of the TrueType rasterizer at a specific point size, and
if the same font is used twice at different sizes in the document, each
instance must have a unique name. PDF Creator contains code to recover
the original font name from the font embedded in the file.

•

Secondly, they recode all the text in the document that uses the font. Every
character code is replaced by its glyph index within the font, and all text
using that font in the document undergoes a similar recoding so that, for
example, a string Hello in the original document appears as +HOOR in the
PostScript language file. Because the font and text are both recoded, the
string +HOOR still gets printed on paper as Hello, but if the recoded font is
distilled into PDF exactly as it appears in the PostScript language file, you
are not able to search for Hello in the PDF file, nor cut and paste text from
the PDF file to other documents.

If you enable TrueType font substitution, PDF Creator attempts to replace the
Type 3 or Type 1 font used in the PostScript language file with the original TrueType font from disk. This lets you embed the real, hinted font in the PDF file,
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which in turn leads to more legible text when the document is viewed and printed.
PDF Creator will also undo the effect of the font recoding, so that all strings such
as +HOOR in the file are turned back into Hello.
This process is normally reliable. There are however, a few situations that can
cause problems:
•

Code pages. Windows uses two different kinds of TrueType font – those
that support more than one code page and those that do not. You can distinguish between the two by looking in the Fonts menu of an application. If
the font name appears several times with various locale names in parentheses, the font supports multiple code pages; if it appears only once, it supports just one. An example of the former is Impact; an example of the latter
is Onyx. Some fonts, such as Verdana, support multiple code pages on
Windows NT but only one code page on Windows 95.
The Windows 95 printer driver supports code pages in such a way that PDF
Creator is still able to perform TrueType substitution. Text in the document
from the “basic Windows” (or “Western”) code page is subject to the full
substitution process, so that recoded text strings are decoded. Text from
other code pages (for example, Greek, Cyrillic) are rendered with the correct
TrueType font. However, text from these code pages is not decoded, and is
not searchable in the PDF file.
The Windows NT printer driver supports code pages in a different way.
Only text from the basic Windows code page gets substituted. Text from
other code pages is printed as bitmapped graphics, and is not recognized as
text by PDF Creator.

•

As mentioned above, some font files, such as Verdana, are different on
Windows 95 and NT. Since the recoded text in a PDF file is based on the
glyph index within the font file, it is important not to mix up different versions of the same font. Jaws ToPDF does not disable TrueType substitution,
so if you use it to convert a document using a bitmap or outline font that
can be substituted with a TrueType font, it is substituted. However, if the
PostScript language file was originally produced on a different operating
system to the one on which Jaws ToPDF is running at the time, the text in
the PDF output file may be garbled, due to the mismatch between the fonts
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on the two systems. If you are using Jaws ToPDF in this way, make sure
you always convert PostScript language files that were created on the same
system.
•

The algorithm that the Windows NT driver uses to alter the font name is
documented, but not always reversible. PDF Creator may occasionally fail
to substitute a TrueType font because it is reconstructing the original font
name incorrectly, and therefore cannot find the original font on the disk.
This most likely occurs if you are subjecting the font to geometric transformations, such as shearing the font to simulate an oblique face. This kind of
transformation is not possible with many Windows applications, so you are
unlikely to see this.

•

The font is not being recoded when PDF Creator expects it to be. The Windows NT PostScript printer driver sometimes does not recode fonts when
embedding them. This is under control of the application printing the document, and is documented as a “legacy” feature in the driver. Because there
is no guaranteed indication in the PostScript language file that this has happened, PDF Creator may still decode the text in the normal way. This leads
to garbled text in the PDF output file.

It is possible to correct these last two situations, by editing the tables in the file
default\startup.ps in the PDF Creator installation directory. You can edit this
file using any standard text editor.
In this file there are two tables, one called NTfontnames, and the other called
NTfonttypes. These are both PostScript dictionaries, located near the end of
startup.ps. The syntax of a PostScript dictionary is as shown:
/NTfontnames <<
/My#font0432 /My_font
>> def

The name of the dictionary appears first, followed by the contents, delimited by
angle brackets. The keyword def associates the dictionary contents with its name.
The dictionary contents are a list of pairs, in free format, although sticking to one
pair per line makes the dictionary easier to maintain by hand.
NTfontnames is used to handle fonts whose names PDF Creator is unable to rec-

ognize automatically. In this case, each pair in the dictionary consists of two PostScript names. A name is introduced by a slash (/), and consists of the characters in

60

Jaws PDF Creator 2.1: issue date January 2002

A.2

Advanced topics

the name. Spaces are not allowed in names, but the font names you are using here
will not contain spaces. The first name in the pair is the font name as it appears in
PostScript language output. The second is the actual font name.
To discover the font name that is being generated in the PostScript language output, you can produce a small sample document and select Print to file when printing it. This will generate a PostScript language file which you can then inspect
using a text editor. You can then search for lines that look like:
%%BeginFont: My#font0432

which signal the start of an embedded font. The font name is the name following
the colon. This becomes the first string in the pair that you are adding to the
NTfontnames dictionary.
The second name in the pair is the PostScript Name field from the TrueType
font’s name table. If you have access to TrueType font editing tools, you can
extract this name directly. Otherwise, you can see which fonts PDF Creator has
found by inspecting the file _edir_ in the font folder in the PDF Creator installation folder. This file contains a large dictionary which maps font names to file
names – you can search down the left-hand column with a text editor until you
find the name you want.
The font name must not contain any spaces, a font name of “My font” is not
acceptable. If you extracted the name directly from the TrueType font, you must
replace any spaces with underscore characters to produce My_font; notice that the
font names in the _edir_ file have already had this substitution made.
NTfonttypes is used to handle fonts that have not been recoded as expected. In

this table, each pair in the dictionary consists of one name and one integer. The
name is the font name, and is found according to the same rules as the second
name in NTfontnames, above. The integer is a code telling PDF Creator whether
or not to decode text that uses this font. A value of 0 means decode, a value of 2
means do not decode.
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A.2.2.4 TrueType fonts with the Adobe printer drivers for Windows
The Adobe printer drivers for Windows 95 can also send TrueType fonts to the
printer as bitmaps and outlines. Unfortunately, they do not include enough information in the file to allow PDF Creator to identify the TrueType font concerned,
so no substitution takes place. The resultant PDF file contains jagged, unsearchable text.
These printer drivers can also send fonts to the printer as Type 42 fonts. Whether
you can select this from the printer driver Control Panel depends on the printer’s
capabilities – the standard PDF Creator PPD file does allow you to select this, but
other PPD files might not. If you choose to do this, you get a hinted TrueType font
embedded in your PDF file, but the text will not be searchable.
In summary, if you want to get the best results when producing a PDF file from a
document that uses TrueType fonts, you should use the Microsoft printer drivers
and enable TrueType substitution in PDF Creator. This gives you the best visual
quality, and you are able to search for text in the PDF file and cut and paste text
from the file to other applications. If, for some reason, you need to use either of
the Adobe printer drivers, you should elect to send TrueType fonts to the printer
as Type 42 fonts. This gives you the best visual quality when viewing the PDF file,
but you are not able to search for text in the file or cut and paste text to other
applications. Please note that the licence from Adobe, for use of their latest PostScript drivers for Windows 95 and NT precludes the use of those drivers to print
to printers which do not contain an Adobe interpreter. PDF Creator does not contain an Adobe interpreter.

A.2.2.5 Searchable text in a PDF
Device font substitution may result in some glyphs being omitted, if they are
present in the TrueType font but not in the substitution font.
TrueType font substitution is more successful in Windows NT/98, and the corresponding settings for these operating system printers are shown below.
To configure your printer for font substitution, you must:
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•

Set the printer to substitute for device fonts.

•

Select the alternative base 14 font for the system font being used.
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Windows NT
To configure whether to download TrueType fonts as Softfonts or to substitute for
device fonts:
1. Right-click the Jaws PDF Creator printer.
2. Select Document Defaults.
3. In the Advanced tab, select TrueType Font under Graphic.
4. Under the TrueType Font Settings select either Substitute with Device
font or Download as Softfont.
To change the Font Substitution table:
1. Right-click the Jaws PDF Creator printer.
2. Select Properties.
3. In Device Settings tab, under Font Substitution Table, change the required
system font to an appropriate base-14 font from the list.
Windows 98
To configure whether to download TrueType fonts as Softfonts or to substitute for
device fonts:
1. Right-click the Jaws PDF Creator printer.
2. Select Properties.
3. In the Fonts tab, select Send TrueType fonts to the printer according to the
font Substitution Table button.
To change the Font Substitution table:
1. In the Fonts tab select the Edit the Table button.
2. In the fonts list, change the required system font to an appropriate base 14
font from the list.
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A.2.3 PostScript ProcSet resources
Fonts are one kind of resource that the PostScript printer driver may embed in a
PostScript language file. Procedure sets, or “ProcSets” are another. Typically, both
the printer driver and the application itself can generate ProcSets, which are used
to define PostScript language procedures which are frequently used by the document. These ProcSets are identified by comments within the PostScript language
file.
The convention used for these identifying comments allows a printer driver to
omit a resource from a file when it is first generated, and subsequently arrange
either for the printer to read the resource off disk, or for the spooler to insert the
resource into the job immediately before sending it to the printer.
Control over application-generated ProcSets is left to the individual applications,
and may not be possible.
You can instruct PDF Creator to intercept ProcSet resources in files sent to it, and
save them to disk for later use. This option is not accessible from the PDF Creator
Control Panel. Instead, you must find the following lines in the file prologue.ps
in PDF Creator’s default directory.
%%%%%
% Here’s how to turn on Resource Capturing.Uncomment the next line
%systemdict /NiknakDict get begin /ExtractResources true def end

To enable saving of ProcSet resources to disk, uncomment the line by removing
the % character from the beginning of the line. Once the ProcSets have been saved
to disk, you are able to send jobs with the ProcSet resources omitted to PDF
Creator, and have them processed properly. If PDF Creator detects that a job
requires a ProcSet resource that has not been saved to disk it issues a warning
message to that effect, although the job will probably fail with a PostScript language error.
PostScript ProcSet resources normally have a version number as well as a name;
PDF Creator treats ProcSets with the same name but different version numbers as
being completely different.
When using this feature, you should bear in mind that ProcSets are PostScript language code and usually subject to copyright restrictions. Saving the resources to
disk is equivalent to permanently downloading them to a printer – the authors of
your application may or may not have granted you permission to do this.
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You should only make use of this feature if you are working in a controlled environment and you are already comfortable with the idea of ProcSet resources.

A.2.4 Custom PostScript language files
There are three PostScript language files that are executed by the interpreter. They
are found in the Default subfolder of the folder where you installed PDF Creator.
You can use these files for any custom PostScript language code that you want to
be executed. Needless to say, you should only modify these files if you are comfortable with writing PostScript language code.
Windows: These files are in the C:\Program Files\JawsSystems\Jaws
PDF Creator\Default.
MacOS: The files are in the System folder:Extensions:Jaws PDF
Creator Resources:default.

A.2.4.1 startup.ps
This file is executed when the interpreter first starts up. You can use it to make
any global changes. In particular, the parameters that PDF Creator uses for the
JPEG and CCITT image compression filters are stored here, as well as the lists of
TrueType fonts that need special handling by the TrueType substitution code.
The image compression parameters are stored in four PostScript dictionaries at
the start of the file, which give the parameters for the JPEG low, medium and high
compression filters, and the CCITT fax compression filter respectively. If you
understand how the PostScript compression filters work, you can modify the
parameters here to change the behavior of the filters. The most common example
might be to change the Q factor for one or more of the JPEG filters.
The TrueType dictionaries are stored near the end of the file, and are initially
empty. You can add the names of any fonts that you have determined require special handling by the TrueType substitution code. For more information on the
format of these dictionaries see Section A.2.2, “Font embedding”.

A.2.4.2 prologue.ps
This file is executed by the interpreter at the start of each job. This gives you the
opportunity to make any changes that you want to apply on a per-job basis.
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There are three pieces of example code here that you can use directly.
The first section of code enables collection of PostScript ProcSet resources. The
line:
systemdict /NiknakDict get begin /ExtractResources true def end

turns on the collection of resources from incoming PostScript language jobs. After
installation, this line is commented out – the % at the start of a line introduces a
PostScript language comment. To enable collection of ProcSet resources, uncomment the line by removing the %, using a text editor. When you have collected all
the ProcSet resources you need, you should comment out this line again.
The code to override the default author and creator information (normally
extracted directly from the PostScript language file being converted) that is stored
in the Info dictionary in the PDF output file is also located here. The code for each
field is similar.
The PostScript procedure DoAuthor changes the author name:
(: YourNameHere) DoAuthor

This causes YourNameHere to appear as the author of the document. DoAuthor
works by mangling the %%Author comment present in the job, which is why the
operand to DoAuthor must start with a colon and space before the name itself.
The PostScript procedure DoCreator changes the creator in the same way:
(: CreatorName) DoCreator

After installation, the example lines for DoAuthor and DoCreator in
prologue.ps are both commented out. If you wish to change the author or creator information, you must uncomment these lines by removing the initial % as
well as changing the strings to reflect the names that you want.

A.2.4.3 epilogue.ps
This file is executed by the interpreter at the end of each successful job. Any PostScript language code placed here is included in the PDF file (if it generates any
pages of output). More importantly, you may wish to place any calls to pdfmark
here that you want to be applied to all jobs you convert.
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A.3 MAP OF INSTALLED FILES
The following tables list all the folders and files placed on your disk when you
install PDF Creator.

A.3.1 Windows installation files
In the table below, Windows refers to the Windows folder and is relevant to Windows 95, 98, NT, Me and 2000.
Jaws PDF Creator refers to the folder in which you installed PDF Creator.
The default installation folder is on the same drive as your Windows installation
and is Program Files\JawsSystems\Jaws PDF Creator.
Jaws PDF Creator

The main PDF Creator folder

ToPdf.exe

The PostScript language to PDF conversion utility

Readme.txt

A Text file with late-breaking news

PDFCreator.hlp

The PDF Creator on-line help files

PDFCreator.fts
PDFCreator.cnt
PDFCreatorHlp.ico
Manual.pdf

This manual in Acrobat PDF format

Licence.txt

A text file containing a copy of the end-user licence agreement

PDFCIS.dll

A helper library required when uninstalling

PDFCreator95.inf

Windows 95 setup information. Can be used to reinstall the PDF
Creator printer if accidentally deleted

JawsPDFCreator.dot

These are the macro files for Word97/2000. JawsPdfCreatorInit.dot is a
copy of the file installed in the Word “startup” directory and is provided
JawsPDFCreatorInit.dot so that you can add it to a subsequently installed copy of Word
Default

See general files

Font

See general files

Resource

See general files

\temp

This folder is used for temporary files during conversion, and should normally be empty between jobs

\TTFont

This folder is used for TrueType font stub files

\PFBFont

This folder is used for ATM font stub files
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The following files are installed in various Windows directories on Windows NT
systems:
Windows\system32\spool\drivers\w32x86
PDFCreator.PPD

The PostScript Printer Description file. This defines the capabilities of the
PDF Creator printer to the printer driver

Windows\system32
PDFCreator.cpl

The PDF Creator Control Panel

PDFCreator.dll

The PDF Creator PostScript language-compatible interpreter

PDFCreatorSV.exe

Contains the main part of PDF Creator, the actual interpreter

The following files are installed in the Windows directory on Windows 95/98
systems:
Windows\system
PDFCreator.cpl

The Control Panel applet for configuring PDF Creator

PDFCreator.dll

Contains code to manage the PDF Creator port

PDFCreatorSV.exe

Contains the main part of PDF Creator, the actual interpreter

PDFCreator.ppd

The PostScript Printer Description file, used by the Microsoft PostScript
driver, it defines the capabilities of the PDF Creator printer

PDFCreator.spd

A simplified PostScript Printer Description file, used by the Microsoft
printer driver, it defines the capabilities of the PDF Creator printer

A.3.2 MacOS installation files
Jaws PDF Creator
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Jaws PDF Creator

The default installation folder. This folder is created in the top-level folder
of the volume that contains your active system software unless you
choose a different location in the Installer

Jaws ToPDF

The PostScript language to PDF conversion utility

Read Me

A SimpleText file containing important user information

Make Jaws PDF
Creator

A small application that creates the PDF Creator Desktop Printer that is
necessary for printing from any application. Since a Desktop Printer is
automatically created by the installer, you should not normally need to
use this application
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Manual.pdf

This manual in Acrobat PDF format

Scripts folder

Contains two scripts one for Eudora and one for Outlook Express. For
more information see “Execute on job completion – Windows Launch
application on job completion – MacOS” on page 26

Map of installed files

System Folder Items
Extensions Folder

Components of the Apple LaserWriter driver v8.6

LaserWriter 8

The Apple LaserWriter 8.6 PostScript Printer driver

PrintingLib

A shared library required by the LaserWriter driver

Jaws PDF Creator
Resources

This folder contains the resources that are required by PDF Creator. (See
separate table for more information)

Printer Descriptions

The PostScript Printer Description file, used by the LaserWriter driver, it
defines the capabilities of the PDF Creator printer

Jaws PDF Creator PPD

Preferences /Jaws PDF This file contains all of your PDF Creator Preferences and
Creator Preferences
Configurations
Printing Plug-ins

The core PDF Creator PostScript language to PDF converter library

Jaws PDF Creator
Control Panels

Jaws PDF Creator. The Jaws PDF Creator Control Panel.

Jaws PDF Creator Resources
Jaws PDF Creator
Resources

This folder (found in your Extensions folder) contains items that are
required by PDF Creator

Jaws PDF Creator File
App

A small application that prompts you to enter a PDF file name. This is
used by PDF Creator during the conversion process

Default

See general files

Font

See general files

Resource

See general files

A.3.3 General files used by all operating systems
Default

A folder PDF Creator uses for miscellaneous files

/epilogue.ps

A PostScript language file run after every job (see Section A.2.4.3)

/prologue.ps

A PostScript language file used to configure PDF Creator (see
Section A.2.4.2)
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Default

A folder PDF Creator uses for miscellaneous files

/startup.ps

A PostScript language file run at startup, contains compression settings
(see Section A.2.4.1)

Font

The folder PDF Creator uses for the 35 resident fonts.
The data in these files is copyright Stream Technologies Inc., and is not
licensed for use with any software other than PDF Creator

Resource
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This folder contains all the PostScript resources (other than fonts) that
are known to the interpreter, and which may be loaded by the
findresource operator

Jaws PDF Creator 2.1: issue date January 2002

Index

C
Compression tab
Compress text 31
Compression filters 31
Downsample 31
Resolution 31
Control Panel reference 18
Compression tab 30
Font embedding tab 32
General tab 24
Reporting tab 35
Security tab 34
Settings tab 19
Create a PDF file
and launch Acrobat Reader 12
compatible with Acrobat 1.2 and 1.3 11
containing bookmarks and links 9
from an application 8
from an EPS 8
that can be sent by e-mail 11
using a custom page size 9
using compression 11
without prompting for a file name 10
Create Outlook Message 27
Custom PostScript language files
epilogue.ps 66
prolog.ps 65
startup.ps 65

F
File names
Always output files to.. 56
Overwrite an existing PDF file 56
Font embedding
TrueType fonts 57

Jaws PDF Creator 2.1: Issue date January 2002

Type 1 fonts 56
Type 3 fonts 57
Font embedding tab
Always embed 32
Embed all fonts (except Base 14 fonts) 32
Embed Base 14 fonts 33
Never embed 32
Subset fonts 33
Use original TrueType fonts – Windows
only 33

G
General tab
Advanced button 28
ASCII format 25
Auto-rotate pages 25
options 26
PDF file format 24
Resolution 25
Thumbnail generation 24

H
How Jaws PDF Creator works 51

I
Introduction 1

J
Jaws ToPDF
Configuration 16
drag-and-drop 14
Jaws ToPDF Configuration
Always output files to... 17
Always prompt for a destination 17

71

Do not prompt for a destination 17

L
LZWDecode 45
LZWEncode 45

M
Map of installed files
General files used by all operating
systems 69
MacOS installation files 68
Windows installation files 67
Microsoft Word macro 37
settings 37
About tab 42
Bookmarks tab 40
Comments tab 41
Document tab 38
General tab 37
Links tab 39

Security tab
Do not permit users to 35
Encrypt PDF files 34
Passwords 34
Serial number 5
setdistillerparams 45
Settings tab
About PDF Creator 22
Font management button 21
System Requirements 3

T
Troubleshooting 43
TrueType fonts
Adobe printer drivers for Windows 62
MacOS LaserWriter driver 57
Microsoft printer drivers 58

P
PDF Creator
Advanced topics 54
Custom PostScript language files 65
File names 54
Font embedding 56
PostScript ProcSet Resources 64
Control Panel reference 52
Compression tab 30
Font embedding tab 32
General tab 24
Reporting tab 35
Security tab 34
Settings tab 19
Integration with the Windows
system 52
MacOS integration 52

R
Reporting tab
Create individual log files for each
job 36
Discard messages 36
Display messages 36
Log all messages to 36
Only log errors 36

S
Searchable Text in a PDF 62

72

Jaws PDF Creator 2.1: Issue date January 2002

